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Cautions

• The reproduction of all or part of this manual without our permission is
prohibited.

• The information contained in this manual is subject to change without
notice.

• We have made every effort to produce a perfect manual, but should you
find any mistakes, we would be grateful if you would kindly let us
know.

• We shall take no responsibility for consequences resulting from the
operation of this product, despite the terms mentioned above.

Warning!

The CD-ROM on which this software is distributed should not be played
back on audio CD equipment.  Playing CD-ROMs on an audio CD player
could cause hearing loss or damage the equipment.

Trademark Information

IBM and IBM PC/AT are registered trademarks of International Business
Machines Corporation.
Windows and MS-Windows are trademarks of Microsoft corporation.
Microsoft Video for Windows is a product of Microsoft corporation.
All other brand or product names mentioned in this manual are the
trademarks or registered trademarks of their respective holders.
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Notice concerning prohibition of copying or reproduc-
tion

Note that simply being in possession of material which has been copied or
reproduced by means of a digital camera may be punishable by law.

Items prohibited by law from being copied or reproduced

Do not copy or reproduce paper money, coins, securities, government
bonds, or local government bonds, even if such copies or reproductions are
stamped “Sample”.

The copying or reproduction of paper money, coins, or securities which are
circulated in a foreign country is prohibited.

The copying or reproduction of unused postage stamps or post cards issued
by the government without obtaining approval from the government is
prohibited.

The copying or reproduction of stamps issued by the government and
certified documents stipulated by law is prohibited.

Cautions on certain copies and reproductions

The government has issued cautions on copies or reproductions of
securities issued by private companies (shares, bills, checks, gift
certificates, etc.), commuter passes, or coupon tickets, except when a
minimum of necessary copies are to be provided for business use by a
company. Also, do not copy or reproduce passports issued by the
government, licenses issued by public agencies and private groups, ID
cards, and tickets, such as passes and meal coupons.

Comply with copyright notices

The copying or reproduction of works such as books, music, paintings,
woodcut prints, maps, drawings, movies, and photographs which are
copyrighted creative works is prohibited except when it is done for
personal use at home or for similar restricted and non-commercial use.
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1Overview

Overview

Welcome to Nikon View for Windows, a companion program for the
COOLPIX 300. Nikon View offers a combination of browser, simple
editing, and file-transfer capabilities. Using these three functions, you can
play back images and audio data from your camera’s memory, edit them in
Nikon View’s document window, and save them to your computer for use
in other applications or for long-term storage. Once you have installed
Nikon View and mastered its simple tool buttons and menus, you’ll be able
to distribute your digital photographs by disk or electronic mail, or include
them in your home page and other documents you create for business or
personal use.

Nikon View’s features include:

• a browser function which allows you to preview at a glance all the
images and recordings stored in your camera’s memory, and to select
items for editing, transfer to disk, or deletion

• compliance with the TWAIN standard, making it possible to launch the
browser from any application, such as Adobe Photoshop, which
supports TWAIN-compatible acquire plug-ins

• rapid transfer of photographs, memos, and audio data to your computer
with a few mouse clicks

• playback of audio data using either the camera’s built-in speaker or
your computer’s audio system

• simple editing of image data using Nikon View’s one-touch tool palettes
and menus

• support of TIFF, JPEG and BMP image formats, giving you added
flexibility when using images created with your COOLPIX 300 in other
applications or when distributing photographs by diskette or electronic
mail

• support of the WAV audio format, allowing you to play back sound
recordings using standard Windows software
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This manual will guide you, step-by-step, through the process of setting up
and using Nikon View with your COOLPIX 300. The next section, “Before
You Begin,” gives details of how to install Nikon View on your computer. It
is followed by “Getting Started,” which introduces you to the basics of
using Nikon View to preview the contents of your camera’s memory, select
items for editing or playback, and save images and recordings to disk.
Refer to “Using the Browser” and “Working with Documents” for detailed
information on using Nikon View’s browsing and editing functions.

Note for users of Windows 3.1: The menus and dialog boxes included
in this manual are those which appear in the Windows 95 version of Nikon
View. Differences between the Windows 3.1 and Windows 95 versions are
noted in Appendix A.
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Before You Begin

This section gives the system requirements for Nikon View for Windows
and guides you through the process of installing Nikon View to your
computer’s hard disk.

Note: This manual assumes a basic understanding of common Windows
operations. If you are in doubt about the meaning of terms used here, refer
to your Windows’ manual.

System Requirements

Nikon View for Windows is a 32-bit application. To run Nikon View for
Windows, you will need system hardware and software which meet the
following minimum requirements:

• an IBM PC/AT or compatible computer with a i386 or later CPU

• either Windows 95, or Windows 3.1 or later

• at least 8 MBs of free RAM (12 MBs or more is recommended)

• 2.5 MBs of free space on your hard-disk for installation (of which at
least 1.5 MBs of which must be available in the Windows directory),
with another 20 MBs of free hard disk space available for temporary
storage while Nikon View is running

• a monitor with a resolution of 640 × 480 dots or higher and a video
system which supports 24-bit True Color (16.7 million colors)

• a CD-ROM drive for installation

• a serial port or SCSI adaptor for connection to the COOLPIX 300 (note
that to connect the COOLPIX 300 to a SCSI adaptor you will require
the optional COOLPIX 300 SCSI Kit)
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Installation

The installation disk provided with this product contains the Nikon View
browser software and drivers which handle the exchange of information
between your computer and the COOLPIX 300. Before starting the
installation program, check to be sure that no other applications are
running and that you have enough space on your hard disk to install and
run the program (a minimum of 22.5 MBs of free disk space is required, of
which 1.5 MBs must be available in the Windows directory; more space
will be needed should you choose to install the applications bundled with
Nikon View).  Do not connect the camera to the computer at this time.

Note: The installation process for Windows 3.1 differs slightly from that
described below. See Appendix A.
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Step 1 — Insert the Nikon View disk in the CD-ROM drive

When the Nikon View CD-ROM is inserted in the CD-ROM drive, the
following window will appear on the desktop.

Note:   In addition to Slides and Sounds Plus and PhotoEnhancer, the US
version of the Nikon View installer CD-ROM includes Imagine….  For
more information on these software packages, refer to the README file.

Step 2 — View the README file

It is recommended that you take a few moments to view the README file,
which contains important information about the software provided with
your camera.  Click Read Me to open the README file in the Notepad
application, where the contents of the file can be viewed or printed.  When
you have finished, select Exit  from the Notepad File  menu to return to the
Nikon View Setup window.
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Step 3 — Install Nikon View

To install Nikon View, click the Install Nikon View  button (for
information on installing other the software provided with this product,
refer to the documentation included with this manual).  The window shown
on the previous page will be replaced a dialog offering a choice of
language for Nikon View’s menus and dialogs.

Select a language by clicking the appropriate button (please note that the
menus and dialogs shown in this manual are for the English version).  A
progress indicator will be displayed while the setup program loads.
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Once this initialization process is complete, the following Welcome
window will be displayed.

The buttons available in the Welcome window are explained below.

Next
Opens the Nikon Install dialog box shown in Step 2, allowing you to
complete the installation process.

Cancel
Selecting Cancel  brings up the dialog box shown below. Choose
Exit Setup  to quit
without installing
Nikon View, or
Resume  to continue
installation. Should
you choose to exit the
installation program,
you will still be able
to complete installa-
tion at any time by
repeating the process from Step 1.
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Step 4 — Select a destination directory for Nikon View

Clicking Next  in the Welcome window brings up the Choose Destination
Location dialog box.

The items in this dialog box are explained below.
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Browse
Clicking Browse  brings up the
dialog box shown at right. You
can type a destination directory
for Nikon View in the Path  text
box, or you can click on the
folders shown under Directories
to navigate to an existing
directory on the current
drive. Clicking on the arrow next
to Drives  allows you to select a
another drive from a pop-up
menu. Click OK when you have
chosen a destination directory, or
Cancel  to accept the default
directory displayed in the Choose
Destination Location dialog box.

Next
Installs Nikon View to the selected directory. If the specified directory
does not already exist, it will be created automatically.

Back
Returns you to the Welcome window shown in Step 1.

Cancel
Selecting this item brings up the dialog box shown under Cancel  in the
previous step, allowing you to exit the setup program without installing
Nikon View. You can run the setup program again at any time to
complete installation.
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Step 5 — Complete installation

Clicking Next  in the Install dialog box causes Nikon View to be installed
in the specified directory. The following progress indicators will be
displayed while Nikon View’s program files and drivers are being written
to your hard disk.

Clicking Cancel  interrupts the installation and brings up the dialog box
shown below.

Click Resume  to continue the installation process from the point it was
interrupted. Click Exit Setup  to cancel the installation and return to
Windows without adding Nikon View to your system. You can begin the
installation process again at any time by inserting the Nikon View CD-
ROM into the CD-ROM drive.
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Once the installer has finished copying Nikon View to the destination
directory, the following dialog will be displayed.

Check “Display the README file” to view the contents of the README
file when installation ends (recommended).

Note: The README file may contain important information about Nikon
View which could not be included in this manual.

Click Finish  to exit the setup program. If “Display the README file” is
checked, the README file in will be opened in the Notepad accessory.
When you have finished viewing the README file, choose Exit  from the
File  menu to close the Notepad accessory. The README file can be
viewed again at any time by opening the copy of the README file located
in the directory you chose as the destination for Nikon View.
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Step 6 — Install additional software

When you exit the Nikon View installer, the Nikon View Setup window
shown in Step 1 will be displayed.  Click the appropriate buttons to install
additional software, or click EXIT to end the installation process and return
to Windows.  You can run the installer at a later date to install additional
software by placing the CD-ROM in the drive.
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Step 7 — Register the COOLPIX 300 (SCSI connection only)

If you have purchased the optional COOLPIX 300 SCSI Kit and have a
SCSI adaptor installed in your computer, you can now register the camera
in the Windows 95 Device Manager.  Exit Windows and turn off your
computer, then connect the COOLPIX 300 to your computer’s SCSI chain
as described in the COOLPIX 300 User’s Manual.  Turn on the camera and
then turn on your computer and start Windows.  The following message
will appear on the desktop.

Select Driver from disk provided by hardware manufacturer  and
click OK.  The Install from Disk dialog will appear.

After inserting the installation CD into the CD-ROM drive, enter the drive
letter for the CD-ROM drive in the “Copy manufacturer’s files from: ”
text box and click OK.  A progress indicator will be briefly displayed
while Windows adds the camera to your system.
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Once Windows has registered your COOLPIX 300, you can check that the
camera has been added to your system by clicking the My Computer icon
with the right mouse button and selecting Properties  from the menu that
appears.

This will open the System Properties window.  Select the Device Manager
tab and confirm that the COOLPIX 300 is shown in the list of devices
under “Nikon Digital Camera.”
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Getting Started

Once you have installed the Nikon View software as described in “Before
You Begin,” you are ready to use your computer to view the contents of
your COOLPIX 300’s memory or to transfer images and recordings to your
computer for editing and storage. This chapter provides a brief
introduction to Nikon View’s windows, menus, and buttons, and outlines
the steps you will take when using the program with your COOLPIX
300. More detailed information may be found in the following chapters,
“Using the Browser” and “The Document Window.”

First Steps

This section guides you step-by-step through the basics of using Nikon
View to acquire documents from your camera, modify them, and save them
to disk. An overview of the program’s menus and tool palettes may be
found in the following section, “A Closer Look at Nikon View.” More
detailed information on using Nikon View either independently or with the
camera can be found in the following chapters, “Using the Browser” and
“Working with Documents.”

Step 1 — Connect the COOLPIX 300 to Your Computer

After making sure that both your camera and computer are off, connect the
devices as described in your COOLPIX 300 User’s Manual. Turn the
camera and any other peripheral devices on, then turn on your computer
and start Windows.
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Step 2 — Start Nikon View

Start Nikon View by double-clicking the program’s icon or by choosing the
program from the Start  menu (users of Windows 3.1 can start Nikon View
by opening the Nikon Software program group and double-clicking the
Nikon View icon).

Select
Nikon View
from the Start
menu…

…or double-
click the Nikon
View  icon.
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The program’s main window and tool palette will appear on the desktop.

Main windowTool palette
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The first time you start Nikon View after installing the program or changing
the port used to connect your camera to the computer, the following
message will be displayed.

If you have connected your camera to the computer’s SCSI chain, click
Yes and proceed to Step 3. Clicking No will reveal the message shown
below.

If you have connected your camera to COM port 1 (which on most
computers corresponds to the computer’s main serial port), or if you are
not sure to which serial port your camera is connected, click Yes.  If you
have connected your camera to a different COM port, click No.  If you
click No or if the computer does not find the camera on COM port 1, you
will asked whether the camera is connected to COM port 2.  This
procedure will be repeated until the COM port to which the camera is
connected is found.

Note:   Depending on your computer, the serial ports may be identified as
“SERIAL1, SERIAL2…” rather than “COM1, COM2….”  The difference
is one of name only; even if the port to which your camera is connected is
SERIAL1, you should choose COM1 when so prompted by the computer.
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Step 3 — Acquire Documents from the Browser

Once Nikon View has located the camera, the program’s browser window
will appear within the main window.

You can select a single document (image or recording) from the browser
by clicking its name, or select multiple documents with Ctrl  click. When
you have chosen the documents you want, press the Acquire button in the
browser window tool palette.

The selected documents will be opened in Nikon View’s main window,
where they can be flipped or rotated using the buttons on the main window
tool palette or document window tool bar. You can also zoom in on an
image by clicking it or zoom the image out by clicking it while holding the
Ctrl  key down on the keyboard (when the mouse pointer is over an image,
the cursor will change to the shape of a magnifying glass).

Acquire

Browser window
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Step 4 — Save the Documents to Disk

When you have finished playing back and editing the documents, save
them to disk by clicking the Save button on the main window tool bar or by
selecting Save from the File  menu.

The following dialog will appear.

After specifying the file type, name, drive, and directory for the recording,
click Save. The image will be saved in the specified location.

Save
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Step 5 — Quit Nikon View

To exit Nikon View and return to Windows, select Exit  from the File  menu
or click the Exit button in the main window tool palette.

Exit
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A Closer Look at Nikon View

This section introduces you to Nikon View’s main windows and briefly
describes the program’s menus and buttons.Nikon View’s functions are
shared between three types of window: the browser window, which acts
as an interface between the COOLPIX 300 and your computer; document
windows, where images and sounds acquired from your camera can be
viewed and edited; and the main window, which gives you access to the
browser and document windows. When Nikon View is the active
application, most of the operations that can be performed on acquired
images are available from the main window’s menus and tool bar.  In
addition, buttons on the tool palette allow you to perform such tasks as
opening the browser window and rotating and flipping selected images,
even when the browser is being controlled from an application other than
Nikon View.  The commands available in the main, document, and browser
windows are outlined in turn below.
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Tool palette

Document window

Browser window

Main window
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The Main Window

The main window may be thought of as Nikon View’s control center, where
documents (images and sounds) can be acquired from the COOLPIX 300,
played back, modified, or saved to disk. When the browser window is
closed and no document windows are open, only the File  and View  menus
are available and most of the tool buttons will be dimmed and
inactive. When the browser or a document is open in the main window,
the Edit , Tool , and Window  menus will be displayed.

The main window’s menus and buttons are outlined below. A more
detailed explanation of the commands available may be found in the
following chapters, “Working with Documents” and “Using the Browser.”
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The Main Window Control Menu

The control menu can be accessed by clicking the Nikon View icon ( ) at
the top left corner of the main window (the document and browser
windows have their own control menus, which are described elsewhere).

The control menu contains the items listed below.

Restore
Restores the window to its original size after it has been enlarged using
the Maximize  command.

Move
Allows you to use the arrow keys or mouse to change the position of
the main window. When you have moved the window to the desired
position, click the right mouse button or press Enter .

Size
Allows you to use the arrow keys or mouse to change the size of the
main window.

Minimize
Reduces the main window to a button on the taskbar.

Maximize
Enlarges the main window to fill the screen.

Close
Closes the main window, ending your current session of Nikon View.
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The File Menu

The items available in the File  menu differ depending on whether the
browser or document windows are currently open or not. When no
windows are open, the shorter menu at left is displayed; when the browser
is open or when a document has been loaded from disk or acquired from
the camera, the items listed on the menu at right are available.

 

The commands that can be accessed from the File  menu are listed below.

Open…
Allows you to specify the name of an image or sound file that has
previously been saved to disk and to then open it in a new document
window. This command can also be accessed by clicking the Open
button in the tool bar (see below).

Close
Closes the currently active document window.

Save
Saves the currently active document to disk. This command can also be
accessed by clicking the Save button in the tool bar.

Save As…
Allows you to save the currently active document to disk under any
name you specify.
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Print…
Allows you to print the currently active document to a printer you
specify. This command can also be accessed by clicking the Print
button in the tool bar.

Print Pre view
Allows you to determine how the currently active document will appear
when printed using the present printer settings.

Print Setup…
Brings up a dialog box which allows you to select a printer and make
changes to the current printer settings.

Preferences…
Brings up the Preferences dialog box, allowing you to specify a scratch
disk for temporary storage of documents acquired from the camera, or
to change the settings for the camera and browser. The Preferences
dialog can also be accessed by clicking the Preferences button in the
tool palette (see below).

About NikonView
Brings up the About window.

Recent Files
The File  menu lists the four most recently accessed documents in this
section. If several document windows are currently open, you can use
this list to switch between documents. If the listed file is not currently
open, selecting it will open it in a new document window.

Exit
Closes the main window, terminating your current session of Nikon
View. You can also quit the program by clicking the Exit button in the
tool palette.
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The Edit Menu

The Edit  menu is only visible when the browser or document windows are
open.

The Cut, Copy , Paste , and Delete  commands are available when you
have opened a dialog containing a text box, such as the Save As or Scratch
Disk dialogs.  The command shortcuts listed in the menu allow you to copy
(Ctrl+C ) or cut  (Ctrl+X ) selected text from one dialog and paste (Ctrl+V )
it in another, or to delete selected text by pressing the Del key. You can
not use these commands to copy image or audio data between documents.

The Select All  command is available when the browser window is open
and can be used to select all the documents in the camera’s memory for
deletion, editing, or acquisition.  You can also use the Delete  command
when in the browser to delete selected items from the camera’s memory
(see “Deleting Documents” in the chapter “Using the Browser,” below).
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The View Menu

The items available in the View  menu differ depending on whether or not a
the browser or document windows are currently open. When no windows
are open, the shorter of the two windows shown below is displayed; when
browser or document windows are open in the main window, the menu
contains the items shown at right.

The commands available in the View  menu are described below.

View Entire Image
This command is available when the current document window
contains an image which too large to be displayed fully. The document
window is enlarged to show the entire image; if the image is too large
to fit in the main window, it will be shown at the highest zoom ratio at
which it can be displayed in its entirety.

Fit Window to Image
Adjusts the size of the active document window to match the
dimensions of the image it contains. If the image is too large to fit in
the main window, the document window will be expanded to the largest
size that can still be contained in the main window. This command can
also be accessed by clicking the Fit Window to Image button in the tool
bar.
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Auto Fit Window to Image
When this item is checked, the document window will automatically be
adjusted to match any changes in the dimensions of the image it
contains.  When the image is rotated or zoomed in or out, the dimen-
sions of the document window will change to show as much of the
image as will fit in the main window.

Show Information
Brings up the Information dialog box, which gives the size, location,
and date of recording of the active document (or of the most recently
selected document in the browser if the browser window is
active). This command can also be accessed by clicking the Show
Information button in the document or browser preview windows.

Play Sound
If the document in the active document window (or, if the browser
window is active, the most recently selected document in the browser)
contains a sound recording, choosing this item will bring up the Play
Sound dialog, allowing you to play the recording back or to save it to
disk. This command can also be accessed by clicking the Play Sound
button in the document or browser preview windows.

Toggle Memo
This command is available when an item containing a memo has been
selected in the browser window.  Using this option, you can control
whether or not the memo will be displayed in the browser preview
window or acquired when the item is transferred from the browser to
another application.  This command can also be accessed using the
Toggle Memo buttons in the browser’s preview window.

Show Browser
Brings up the browser window (see “The Browser Window,” below).
The browser window can also be opened by clicking the camera icon in
the main window tool palette.

Toolbar
If there is a check-mark next to this item, the main window tool bar will
be displayed.

Status Bar
If this item is checked, a status bar will be displayed at the bottom of
the main window (see “The Status Bar,” below).
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The Tools Menu

The Tools  menu is only available when browser or document windows are
open.

The items in the Tools  menu are explained below.

Flip
This item gives access to the following submenu.

Horizontal:   If the browser window is active, choosing this item will
flip all selected images in the browser horizontally.  If a document
window is active when this item is selected, any images it contains will
be flipped.  This command can also be accessed by clicking the Flip
Horizontal buttons on the main window tool palette or the document
window tool bar.
Vertical:   Flips images in the browser or active document window
vertically.  This command can also be accessed by clicking the Flip
Vertical buttons on the main window tool palette or document window
tool bar.
Both Axes:   Flips images in the browser or active document window
both horizontally and vertically.
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Rotate
This item gives access to the following submenu.

90˚ CW:  Rotates images in the browser or active document window
ninety degrees clockwise. This command can also be accessed by
clicking the Rotate 90˚ Clockwise buttons on the main window tool
palette or document window tool bar.
90˚ CCW:  Rotates images in the browser or active document window
ninety degrees counter-clockwise. This command can also be accessed
by clicking the Rotate 90˚ Counterclockwise buttons on the main
window tool palette or document window tool bar.
180˚:  Rotates images in the browser or active document window 180˚.
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The Window Menu

The Window  menu is only displayed browser or document windows are
open.

The following items are available in the Window  menu.

Cascade
When several documents are open at the same time, choosing this
command arranges them in overlapping windows of equal size.

Tile
Arranges documents in non-overlapping windows of equal size that
together fill the main window.

Close A ll
Closes the browser and all open document windows.

Arrange Icons
Returns all iconized document windows to their original positions at he
bottom of the main window.

Open Windows
The names of all windows currently open in Nikon View’s main
window are displayed at the end of the Window  menu. The active
window is indicated by a check mark; another window can be activated
and brought to the front by selecting it from this list.
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The Main Tool Palette

When Nikon View is running or the browser is being used from another
application, the following tool palette will appear on the desktop.

The tool palette can be moved anywhere on the desktop by dragging it by
its title bar. When you next start Nikon View or select the browser from the
acquire menu of another application, the palette will reappear in the
position you left it when you last quit the program.

The function of each button is described briefly below. You can also learn
the function of a button by resting the mouse pointer on the button for a
few seconds. A label will pop up listing its function.

Show Browser Clicking this button brings up the
browser window. The browser window
can also be opened by choosing Show
Browser  from the View  menu.

Flip Horizontal When the browser window is active,
clicking this button flips all selected
images in the browser horizontally.  If
the active window is a document
window, any images (photographs or
memos) it contains will be flipped. This
command can also be accessed by
clicking the Flip Horizontal button in
the document window or by choosing
Horizontal  from the Flip  submenu of
the Tools  menu.
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Flip Vertical Flips the image in the browser or active
document window vertically. This
command can also be accessed by clicking
the Flip Vertical button in the document
window or by choosing Vertical  from the
Flip  submenu of the Tools  menu.

Rotate 90˚ Counterclockwise
Rotates the image in the browser or active
document window 90˚ to the left. This
command can also be accessed by clicking
the Rotate 90˚ Counterclockwise button in
the document window or by choosing
90˚ CCW from the Rotate  submenu of
the Tools menu.

Rotate 90˚ Clockwise
Rotates the image in the browser or active
document window 90˚ to the right. This
command can also be accessed by clicking
the Rotate 90˚ Clockwise button in the
document window or by choosing 90˚ CW
from the Rotate  submenu of the
Tools menu.

Exit Terminates your current session of Nikon
View. This command can also be accessed
by choosing Exit  from the File  menu.

Preferences Brings up the preferences dialog box,
allowing you to change the settings for the
camera and browser. This command can
also be accessed by choosing
Preferences…  from the File  menu.
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The Main Window Tool Bar

The main window tool bar is visible when the Toolbar  item in the View
menu is checked.

The function of each button in the tool bar is briefly explained below. You
can also learn the function of a button by resting the mouse pointer on the
button for a few seconds. A label will pop up listing its function.

Open Clicking this button brings up the Open
dialog box, where you can specify the
name of an image or recording to be
opened in a new document window. The
Open dialog box can also be accessed
by choosing Open  from the File  menu.

Save Saves the active document under its
current name. This function can also be
accessed by choosing Save from the
File  menu.

Cut This button is active when you have
selected text in a dialog containing a
text box, when it allows you to remove
the text from its current location and
place it in the clipboard. This command
can also be accessed by choosing Cut
from the Edit  menu.

Copy This button is active when you have
selected text in a dialog containing a
text box. Clicking this button copies the
selected text to the clipboard. This
command can also be accessed by
choosing Copy  from the Edit  menu.

Tool bar
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When the Status Bar  item in the View  menu is checked, a status bar
appears at the bottom of the main window.

The interactive help window in the status bar displays a brief help
messages about any tool button or menu command you move the mouse
pointer across. At the right-hand end of the status bar are boxes which
give information on whether the CAPS, NUM, and SCROLL locks are on
or off.

The status bar can be hidden by selecting Status Bar  from the View
menu.

Paste Click this button to copy text from the
clipboard to a text box in dialog such as
Open or Save. This command can also
be accessed by choosing Paste  from
the Edit  menu.

Fit Window to Image
Enlarges the active document window
to display all of the image it contains.
This can also be achieved by selecting
Fit Window to Image  from the View
menu.

Print Brings up the Print dialog box, allowing
you to print the active document to the
printer or file you specify. This
command can also be accessed by
choosing Print  from the File  menu.

The Status Bar

Interactive help CAPS lock off

NUM lock on

SCROLL
lock off
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Document Windows

When a document is read from disk or acquired from the camera, it is
displayed in a document window similar to that shown below.  Document
windows are displayed only within the main window, and cannot be moved
onto the Windows desktop.

Any number of document windows may be open simultaneously, although
only one of these will be active at a time; the active document may be
distinguished from other documents by its title bar. Operations such as
close, save, fit window to image, show information, flip, and rotation
performed using the buttons in the tool palette or the menus in the main
window will affect only the active document.

The title bar of the document window lists the name of the document and,
in the case of images, its zoom ratio. Each document window also has  a
tool bar and a control menu which allows you to perform operations on the
window itself, rather than on the document it contains. The commands
which may be accessed from the document window control menu and tool
bar are outlined below.

Title bar

Tool bar
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The Document Window Control Menu

The document window control menu may be accessed by clicking the note
icon ( ) at the left-hand end of the title bar.

The items in the document window control menu are explained below.

Restore
Restores the window to its original size after it has been enlarged using
the Maximize  command.

Move
Allows you to use the arrow keys or mouse to move the document window
anywhere within the main window. When you have moved the window to
the desired position, click the right mouse button or press Enter .

Size
Allows you use the arrow keys or mouse to change the size of the
document window. The document window cannot be made larger than
the current size of the main window.

Minimize
Reduces the document window to an icon at the bottom of the main
window.

Maximize
Enlarges the document window to fill the main window.

Close
Closes the document window.

Next
Activates the next open window and brings it to the front.
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The Document Window Tool Bar

The commands accessible from the document window tool bar are outlined
below. You can also learn the function of a button by resting the mouse
pointer on the button for a few seconds. A label will pop up listing its
function.

Show Information Brings up the Information dialog box
for the document, giving its size,
location, and date of recording. The
Information dialog can also be accessed
by selecting Show Information  from
the View  menu.

Play Sound If the document contains a sound
recording, clicking this button will bring
up the Play Sound dialog, allowing you
to play the recording back or to save it
to disk. This function can also be
accessed by selecting Play Sound
from the View  menu.

Flip Horizontal Flips the image in the document
window horizontally. This command
can also be accessed by clicking the
Flip Horizontal button in the main
window tool bar or by choosing
Horizontal  from the Flip  submenu of
the Tools  menu.

Flip Vertical Flips the image in the document
window vertically. This command can
also be accessed by clicking the Flip
Vertical button in the main window tool
bar or by choosing Vertical  from the
Flip  submenu of the Tools  menu.
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Rotate 90˚ Counterclockwise
Rotates the image in the document
window 90˚ to the left. This command
can also be accessed by clicking the
Rotate 90˚ Counterclockwise button in
the main window tool bar or by
choosing 90˚ CCW from the Rotate
submenu of the Tools menu.

Rotate 90˚ Clockwise
Rotates the image in the document
window 90˚ to the right. This command
can also be accessed by clicking the
Rotate 90˚ Clockwise button in the main
window tool bar or by choosing
90˚ CW from the Rotate  submenu of
the Tools menu.
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The Browser Window

The browser window acts as the link between your COOLPIX 300 and
Nikon View, or between your camera and other applications which support
TWAIN acquire plug-ins. From the browser window, you can preview
documents stored in your camera’s memory, transfer them to Nikon View
for playback and editing, save them directly to disk without alteration, and
delete images and recordings from the camera’s memory. Images in the
browser window can be viewed flipped or rotated using the buttons on the
main tool palette. The browser window can also be used to control your
camera, allowing you to take photographs or make recordings while the
camera is connected to the computer.

The browser’s functions are divided between the browser window tool
palette and the preview window. The preview window is used to view the
contents of the camera’s memory, the browser tool palette to control the
camera and acquire, save, and delete documents.

The commands available in the browser window are outlined below. For
more information on using the browser, see “Using the Browser.”

Tool
palette Preview

window
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The Browser Window Control Menu
The browser window’s control menu can be accessed by clicking the icon
( ) at the left end of the title bar.

The browser window control menu contains the items listed below.

Restore
Restores the window to its original size after it has been enlarged using
the Maximize  command.

Move
Allows you use the arrow keys or mouse to change the position of the
browser window. When you have moved the window to the desired
position, click the right mouse button or press Enter .

Size
Allows you use the arrow keys or mouse to change the size of the
browser window.

Minimize
Reduces the browser window to an icon.

Maximize
Enlarges the browser window to fill the screen.

Close
Closes the browser window, returning you to the main application.

Next
Activates the next open document window and brings it to the front.

When the browser is being controlled by an application other than Nikon
View, the command About Nikon View  is shown at the bottom of the
control menu.  See “The About Window,” below.
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The Browser Window Tool Palette

The function of each of the buttons in the browser window tool palette is
given briefly below. You can also learn the function of a button by resting
the mouse pointer on the button for a few seconds, which will cause a label
to pop up identifying it by function. More detailed information on the
browser window tool palette may be found in “Using the Browser.”

Shutter Triggers the camera’s shutter, taking a
photograph at the camera’s current
settings. For more information on
changing the camera’s settings before
you take a photograph, see “Using the
Browser.”

Acquire This button is available when one or
more documents have been selected in
the preview window. The selected
documents are opened in the calling
application, where they may be edited
or saved to disk in a new format.

Delete This button is available when one or
more documents have been selected in
the preview window. Clicking the
button (or selecting Delete  from the
Edit  menu in Nikon View) brings up the
Delete Items dialog, allowing you to
permanently remove the selected items
from the camera’s memory.

Save When one or more items have been
selected in the preview window,
clicking this button saves the selected
items under their current names exactly
as they are stored in the camera’s
memory. Any changes made to the
documents in the browser or main
window will not be saved.
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Show Thumbnails Causes a thumbnail preview of each
item in the camera’s memory to be
displayed in the preview window.

Hide Thumbnails Displays the contents of the camera’s
memory as a simple list, without
thumbnails.

Sort by Time Orders the items in the preview window
by date.

Sort by Name Orders the items in the preview window
by name.

Ascending Sorts the items in the preview window
in ascending order by name or date.

Descending Sorts the items in the preview window
in descending order by name or date.

Battery Level Shows the camera’s current battery
level.

The browser window tool palette also lists the total number of documents
stored in the camera’s memory and the number of documents currently
selected.

Number of
documents
selected

Number of
documents
in memory
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The Preview Window

Each document listed in the browser’s preview window has three buttons,
which can be used to determine whether the document contains a recording
or a memo, get information about the document, to play back sound
recordings, and to control how memos are displayed.

The functions of these buttons are briefly described in the following list. You
can also learn the function of a button by resting the mouse pointer on the
button for a few seconds. A label will pop up giving its function.

Show Information Brings up the Information dialog box
for the document, giving its name, size,
and date of recording.

Play Sound This button will be active only if the
document contains a sound recording.
If the document contains a sound
recording, clicking this button will
cause the recording to be played back
from either the camera’s built-in
speaker or your computer’s sound
system.

Toggle Memo This button will only be active if the
document contains a memo. If the
button contains a pencil icon, the memo
will be overlaid on the photograph when
the document is acquired or previewed.
Clicking the Toggle Memo button
causes the icon to change to a document
icon ( ).  If this icon is displayed, the
memo will not be included when the
document is acquired or played back.

You can also access any of the above three functions by selecting the
corresponding command from the View  menu.
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Using the Browser

The browser is your link between the COOLPIX 300 and your computer.
When the camera and computer are connected, the browser allows you to
use the camera much as you would when operating the camera
independently.  It also makes possible the transfer information from the
COOLPIX 300 to your computer, using Nikon View or any other
application which supports TWAIN-compliant acquire plug-ins. This
chapter details how you can use the browser to perform the following
tasks:

• take photographs while the camera is connected to the computer

• preview the contents of the camera’s memory

• acquire documents from the camera for editing in Nikon View or other
applications

• save the contents of the camera’s memory to disk

• delete documents from the camera’s memory

Also included in this chapter are how to change the camera’s settings from
within the browser and how to set the browser’s preferences. Information
on using Nikon View to edit acquired documents, read files from disk, and
save documents under new names or in different formats is given in the
following chapter.

Note: When the camera is being controlled by the browser, the camera
can only be operated via the browser’s Preferences dialog and the Shutter
button in the browser window tool palette (for more information, see
“ Preferences” and “ Taking Photographs,” below). The camera’s
touch-panel controls and record and shutter-release buttons will be
deactivated.
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Preferences

Nikon View’s Preferences dialog box allows you to control a number of
settings that affect how the program communicates with your camera. By
changing the preferences, you can control:

• your camera’s flash, image quality, speaker, and recording settings;

• whether documents acquired from your camera remain in the camera’s
memory after acquisition;

• whether the browser window remains open after documents are
acquired;

• whether sound recordings are played back using the camera or your
computer’s sound system;

• how annotated photographs will be displayed; and

• where to store temporary files created by the browser.

Changes made to Nikon View’s preferences are saved automatically for use
in your next session.

To open the Preferences dialog box, choose Preferences…  from the File
menu or click the Preferences button in the main tool palette.

Preferences
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The Preferences dialog box will appear.

The Preferences dialog has three tabs which allow you to change the
settings for the browser, camera, and scratch disk. Each of these tabs is
taken up in turn below. When you have finished adjusting the settings,
click OK to put the changes into effect and return to the main window or
Cancel  to discard any changes.
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The Browser Tab

The browser tab in the Preferences dialog box allows you to control how
the browser behaves when an image is acquired and how memos and sound
recordings will be previewed in the browser window.

The options available in the browser tab are listed below.
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Close browser after acquisition
When this box is checked, the browser window will close automatically
whenever documents are acquired from the browser and opened in the
main window. If this item is not checked, the browser window will
remain open until you quit Nikon View or until you click the browser’s
close box (some applications will close the browser automatically after
an image has been acquired).

Delete images after acquisition
When this box is checked, documents will be deleted from the camera’s
memory when they are acquired from the browser and opened in the
main window. If this item is not checked, documents acquired from the
browser will remain in the camera’s memory until you erase them using
the camera’s delete function or the Delete button in the browser
window.

Use Long File Names
When this box is checked, documents saved using the browser’s Save
button can be stored using prefixes that conform to the long file name
format used by Windows 95.  When the box is not checked, prefixes
must conform to DOS filename conventions.

Play sound through Camera or PC
These radio buttons allow you to choose whether sound recordings will
be played back using the camera’s speaker or the computer’s sound
system, if any. Choose Camera  if your computer does not have a
sound card.

Memo Mixer
This slider bar controls how annotated photographs will be displayed.
When the slider is set to the middle, memos will be displayed directly
on the photograph. Moving the slider to the right increases the
transparency of the memo until only the photograph will be visible;
moving the slider to the left gradually increases the transparency of the
photograph until only the memo is visible. You can gauge the effects
of the new setting by observing the sample image displayed under the
slider.
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The Camera Tab

The camera tab in the Preferences dialog box allows you to change the
COOLPIX 300’s settings while the camera is being controlled from the
browser.

The camera tab gives you control over the following camera settings:

Compression Mode  (Image Quality)
Clicking on the arrow to the right of this item
reveals the pop-up menu shown at right,
offering the following choice of image quality settings.
High Compression Ratio: Corresponds to an image-quality setting
of Normal, producing photographs which require relatively little
memory to store.
High Quality: Corresponds to an image-quality setting of Fine,
producing higher-quality images that require twice as much memory to
store as photographs recorded at High Compression Ratio.
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Flash Mode
This item is associated with the pop-up menu
shown at right. From this menu, you can
choose one of the flash settings listed below.
Forced Off: Prevents the flash from firing
even when lighting is inadequate.  Choose this setting when the camera
is being powered by the AC adaptor.
Forced On: Causes the flash to fire whenever the shutter is released.
Auto: Sets the flash to fire whenever lighting is inadequate.
Forced On with Red Eye: The same as Forced On , except that the
red-eye reduction pre-flash will fire before the main flash to minimize
the so-called “red-eye effect.”
Auto with Red Eye: The same as Auto  but with red-eye reduction.

Playback Volume  (Speaker Volume)
The pop-up menu associated with this item
controls the level of the camera’s built-in
speaker (this item has no effect on the volume
of your computer’s speakers).
Whisper:   Corresponds to a Speaker Volume setting of 1 (low
volume).
Normal:   Corresponds to a Speaker Volume setting of 2.
Loud:   Corresponds to a Speaker Volume setting of 3 (maximum
volume).

Record Sound When Taking a Picture  (Recording Mode 1)
When this box is checked, the camera’s recording mode will be set to
Mode 1, causing a sound recording of fixed duration to be made
whenever the shutter is released. The resulting recording will be stored
in the same document as the photograph. The length of the recording
that will be made when the shutter is released can be set by adjusting
the Recording Time  (you can either enter a value directly in the box
to the right of the Recording Time  item or use the arrows to set the
value). Recording time is measured in seconds; any value between one
and thirty is acceptable.
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Confirm settings before taking a picture
When this item is checked, clicking the Shutter button in the browser
tool palette will cause the following dialog to be displayed, allowing
you to change the camera’s Image Quality, Flash, and Sound Mode
settings before taking a photograph.

If this item is not checked, the above dialog will not be displayed when
the Shutter button is clicked.  Instead, a photograph will be taken using
the settings specified in the Preferences dialog box.

For more information on camera settings, refer to the COOLPIX 300
User’s Manual.
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The Scratch Disk Tab

The scratch disk tab in the Preferences dialog box gives you control over
where the browser stores temporary files created when documents are
previewed or acquired. The scratch disk tab is shown below.

The default directory for temporary files is the temporary directory
specified by Windows. You can choose a directory to be added to the list
of Selected Disks  by typing its name in the text box at the bottom of the
window, or you can click the Browse  button to navigate to the desired
directory.
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Clicking the Browse  button brings up the dialog shown above, where you
can navigate through the drives and directories by clicking on the plus (+)
signs. Once you have located the desired directory, select it and click OK.
The directory’s name and path will appear in the text box in the scratch
disk tab.

Once you have chosen a directory, clicking Add  will add it to the list of
Selected Disks . You can change the order in which the selected
directories will be accessed by selecting a directory in the list and clicking
Move Up to move it ahead one place in the list or Move Down  to move it
back one place.  Clicking Remove  will remove the selected directory
from the list of scratch disks.  Before any changes can be put into effect,
you will need to exit the Preferences dialog by clicking OK and then restart
the current application.
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Opening the Browser Window

If the camera is connected to the computer when the application starts up,
the browser will open automatically whenever you start Nikon View (if you
are using another application, the browser will not be shown at start-up but
must be launched from the application’s acquire menu).  If you have since
closed the browser by clicking its close box, you can re-open it by
selecting Show Browser  from the View  menu or clicking the Show
Browser button in the main window tool palette.

Show Browser
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If the camera is connected to the port to which it was attached the last time
you used the browser, the browser window will be displayed inside the
application window.
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 If you have since attached the camera to a different port, the following
message will be displayed when the program attempts to open the browser.

If you have connected your camera to the computer’s SCSI chain, click
Yes. Clicking No will bring up the message shown below.

If you have connected your camera to COM port 1  or if you are not sure to
which serial port your camera is connected, click Yes. If you have
connected your camera to a different COM port, click No. If you click No
or if the computer does not find the camera on COM port 1, you will asked
whether the camera is connected to COM port 2. This procedure will be
repeated until the COM port to which the camera is connected is found.

Note: Depending on your computer, the serial ports may be identified as
“SERIAL1, SERIAL2…” rather than “COM1, COM2….” The difference
is one of name only; even if the port to which your camera is connected is
SERIAL1, you should choose COM1 when so prompted by the computer.
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If Nikon View is unable to locate the camera, either because the camera and
computer are not properly connected, the camera is off, or you failed to
choose the correct port when prompted, the following message will be
displayed.

After clicking OK, check to see that the camera and computer are properly
connected and that the camera is on. If the camera is off or improperly
connected, before you will be able to open the browser you will need to
quit the application, end your Windows session, turn off the computer, and
reconnect the camera and computer as described in the COOLPIX 300
User’s Manual. If you chose the wrong port when prompted, you can click
the Show Browser button again and choose the correct port. The browser
will then open normally.

Note: In addition to Nikon View, the browser can be launched from any
application which supports TWAIN acquire plug-ins (the browser will
appear in the application’s menu of TWAIN sources as “NikonView
Browser”). When the browser is launched from another application, the
browser window and the main tool palette will appear on the desktop. For
information on selecting and launching TWAIN drivers from within
another application, consult the program’s documentation.
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Previewing Documents

Once you have opened the browser window, you are ready to preview the
contents of the camera’s memory.

The browser can be set to show the contents of memory either as thumbnail
previews (shown above) or as a list giving the filename and date of
recording for each item in memory.  When the browser is set to show
previews, memos and photographs in the preview window appear as
thumbnail images, while documents containing only a sound recording are
indicated by a square with an “X” through it (depending on what settings
were chosen for Memo Mixer  in the Preferences dialog, memos or
photographs may not be displayed).
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To speed processing or to view information on the
document’s date of recording, a list-style display can be
chosen by clicking the Hide Thumbnails button in the
browser tool palette.  The list-style display is shown below.

To view the documents as thumbnail previews once more,
click the Show Thumbnails button.  The following progress
indicator will be displayed while the browser reads the
contents of the camera’s memory and creates previews.

Hide
Thumbnails

Show
Thumbnails
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Each document in the preview list occurs with Information, Play Sound,
and Toggle Memo buttons ( ) . If the document does not contain a
sound recording, the Play Sound button will be dimmed and inactive.
Similarly, if the document does not contain a memo, the Toggle Memo
button will be dimmed.

When a document includes a memo, clicking the Toggle Memo button
( ) will hide the memo’s thumbnail preview, giving you a clearer view of
any photographs that may be underneath and preventing the memo from
being transferred to the main window when the document is acquired.
When a memo is present but hidden, the Toggle Memo button shows a
document icon ( ).  Clicking the button a second time will reveal the
memo once more.

To preview a sound recording, click the Play Sound button () associated
with the document in question. A progress indicator will appear while the
recording is loaded into memory.

If Play sound through Camera  has been selected in the Preferences
dialog, the recording will be played back over the camera’s speaker.  If the
selected playback mode is Play sound through PC , the Play Sound
dialog will appear, allowing you to play back selected portions of the
recording or to save the entire recording to disk (see “Playing Back Sound
Recordings” in “ Working with Documents,” below).
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Clicking a document’s Show Information button () will bring up the
Information dialog for the document in question.

The Information dialog lists the title, date and time of recording, and total
memory occupied by the document in question. Click OK to close the
dialog and return to the browser window.
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Memos and photographs in the preview window can be flipped and rotated
using the buttons in the tool palette (for more information on using the tool
palette, see “Working with Documents,” below). To select a document to
be rotated or flipped, click the image in the preview window. Multiple
documents can be selected by holding down the Ctrl  key while clicking
each of the desired documents in turn. Any changes to the document will
be preserved when the document is acquired to Nikon View or another
application, but the changes will not be saved until you have transferred
the document to your computer and saved it as described in the following
chapter,  “Working with Documents.”

Documents in the browser window can be sorted in ascending or
descending order either by date of recording or by name. To list in order
previews by name, click the Sort by Name button in the browser tool
palette. Clicking the Ascending button will then cause the previews to be
listed in alphabetical order, while clicking Descending will list the
previews in reverse alphabetical order. To list previews in order by date,
click the Sort by Time button. Clicking Ascending will then list the most
recently created documents last, while clicking Descending will list the
most recently created documents first.

Sort by Time Sort by Name

DescendingAscending



66 Using the Browser:  Taking Photographs

Taking Photographs

The browser window allows you to use your COOLPIX 300 to take
photographs or make audio recordings even when the camera is connected
to your computer. To take a photograph, ready the camera as described in
the COOLPIX 300 User’s Manual.

Note: When making photographs or recordings from the browser, take
care that the camera does not become disconnected — do not attempt to
move the camera to the limit of the cable. Twisting the SCSI cable could
also result in the camera becoming disconnected or even in damage to the
cable itself.

Once you have framed your photograph in the viewfinder, click
the Shutter button in the browser tool palette.  If the Confirm
settings before taking a picture  item has been checked in
the Preferences dialog, the Take a Picture dialog will be
displayed.

Shutter
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Using the Take a Picture Dialog, changes can be made to the camera’s
Image Quality, Flash, and Recording Mode settings before a photograph is
taken.  The items contained in this dialog are described below.

Compression Mode  (Image Quality)
Clicking on the arrow to the right of this item
reveals the pop-up menu shown at right.  The
following settings are available:
High Compression Ratio: Corresponds to an image-quality setting
of Normal, producing photographs which require relatively little
memory to store.
High Quality: Corresponds to an image-quality setting of Fine,
producing higher-quality images that require twice as much memory to
store as photographs recorded at High Compression Ratio.

Flash Mode
This item is associated with the pop-up menu
shown at right. From this menu, you can
choose one of the flash settings listed below.
Forced Off: Prevents the flash from firing
even when lighting is inadequate.  Choose this setting when the camera
is being powered by the AC adaptor.
Forced On: Causes the flash to fire whenever the shutter is released.
Auto: Sets the flash to fire whenever lighting is inadequate.
Forced On with Red Eye: The same as Forced On , except that the
red-eye reduction pre-flash will fire before the main flash to minimize
the so-called “red-eye effect.”
Auto with Red Eye: The same as Auto  but with red-eye reduction.
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Record Sound When Taking a Picture  (Recording Mode 1)
When this box is checked, the camera’s recording mode will be set to
Mode 1, causing a sound recording of fixed duration to be made
whenever the shutter is released. The resulting recording will be stored
in the same document as the photograph. The length of the recording
that will be made when the shutter is released can be set by adjusting
the Recording Time  (you can either enter a value directly in the box
to the right of the Recording Time  item or use the arrows to set the
value). Recording time is measured in seconds; any value between one
and thirty is acceptable.

Any changes made to the camera’s settings in the Take a Picture dialog are
valid only for the current photograph.  The next time the Shutter button in
the browser window is clicked, the settings given in the Preferences dialog
will have been restored.

Once the settings have been adjusted to your satisfaction, frame a picture in
the viewfinder and click the Shoot  button to make a photograph (if the
Confirm settings before taking a picture  item in the Preferences
dialog is not selected, a picture will be taken as soon as the browser Shutter
button is clicked).  While the camera adjusts its exposure settings and
records a picture, the camera’s READY lamp will blink and a progress
indicator will be displayed.

If Record Sound When Taking a Picture  has been selected, the
camera’s recording lamp will light up and remain on until the recording is
finished.

When the camera has finished recording the photograph or combination of
photograph and audio data, the resulting document will be added to the
preview list under a new name.
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Transferring Documents to Another Application

Images previewed in the browser can be transferred to the application from
which the browser was launched (if the browser was opened from within
Nikon View, sound recordings can also be acquired).  Once a document has
been acquired from the browser, it can be edited or saved to disk using a
new name and format (for information on using Nikon View to save and
edit documents, see “Working with Documents,” below). To select a
document for transfer, click its name in the preview window (multiple
documents can be selected by holding down the Ctrl  key on the keyboard
while clicking each of the desired documents in turn).  If the document
contains a memo that you wish to acquire, be sure that the Toggle Memo
shows a pencil icon ( ).  If the button shows a document icon (), the
memo will not be transferred to the main window when the document is
acquired.

Once all the desired documents have been selected, clicking the
Acquire button in the browser tool palette will open the
documents in the application from which the browser was
launched.  While the documents are being copied to the main
window, the following progress indicator will be displayed.

If the Delete images after acquisition  has been checked in the
Preferences dialog box, the selected documents will be removed from the
camera’s memory once they have been transferred to the browser.
Otherwise the images will remain in the camera’s memory even after
having been copied to the main window.  If Close browser after
acquisition  has been checked, the browser window will be closed once
the images have been acquired.

Acquire
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Saving Documents to Disk

The browser window’s save function allows you to save documents to disk
exactly as they are stored in the camera’s memory. To save a document,
select it from the preview window by clicking its title. Multiple documents
can be selected by holding down the Ctrl  key on the keyboard while
clicking each document in turn.

Once you have selected all the documents you wish to save, click
the Save button in the browser tool palette. The Save As window
will appear. Save
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The options in the browser’s Save As window are explained below.

Save in
Allows you to specify a destination drive and directory for the
documents.

Up One Level
Moves you up one level in the directory structure.

Create New Folder
Creates a new directory under the current directory and allows you to
specify a name for it.

List/Details
Toggles the display to show either a simple list of icons and file names,
or a detailed list giving file name, size, type, and date saved.

Save (Open )
Saves the selected documents in the current directory. If a directory is
selected in the file list, this button will change to read Open . Clicking
this button will then open the selected directory.

Cancel
Returns you to the browser window without saving the selected
documents.

Save Sound
If this box is checked, any audio data included in the selected
documents will be saved as .WAV files. If this box is not checked,
audio data will not be saved.

Generate Unique Names
If this box is not checked, selected photographs will be saved under the
titles used in the browser’s preview window. If this box is checked,
you can enter a prefix in the Prefix  text box. If, for example, the
specified prefix were “IMG,” the first photograph selected would be
saved as “IMG000,” the second as “IMG001” and so forth.  The
numbers following the prefix are assigned by Nikon View; note that
even if you have changed the prefix, numbering does not start again
from zero but continues from the last number assigned.
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To save the photographs you have selected,  first navigate to the desired
drive and folder. Then use the Generate Unique Names  check box to
specify whether you wish to save the photographs under their current titles
or using a prefix of your choice. If you wish to save audio data, make sure
that the Save Sound  box is checked. Finally, click the Save button. A
progress indicator will be displayed while the selected documents are
saved to disk.

Photographs are saved in JPEG (“.JPG”) format at their current
compression ratio; sound images as .WAV files. Memos cannot be saved
from the browser window, but can be saved from the main window once
acquired. Documents are saved exactly as they are stored in the camera;
any flips or rotations performed on the document in the browser’s preview
window or in a document window will not be saved.
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Deleting Documents

While in the browser window, you can delete documents from the camera’s
memory. To select a document for deletion, click its title in the preview
window. Multiple documents can be selected by holding down the Ctrl
key on the keyboard while clicking each document in turn.

Once you have selected the documents you wish to delete, click
the Delete button in the browser’s tool palette.  The Delete Items
dialog will be displayed.

The first document selected will be previewed in the Delete Items window.
You can select which elements of the document you wish to delete by
checking the boxes next to Image , Sound , and Memo . If, for example,
the document included a photograph, an audio recording, and a memo,
checking only Image  would delete only the photograph, while checking
both Image  and Memo  would cause both the photograph and memo to be
deleted. Checking all three boxes would result in the entire document
being deleted, while if no boxes were checked nothing would be deleted.

Delete
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Once you have selected which elements you wish to delete, click Delete  to
delete the selected elements from the document previewed in the Delete
Items window. If multiple documents are selected, the next document will
then be previewed in the Delete Items dialog. Click Cancel  to halt the
operation without deleting further documents. Clicking Delete All  deletes
the chosen elements from all selected documents. Note that deleted items
are permanently removed from the camera’s memory; be sure to save
documents you want to keep before deleting them.
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Working with Documents

This chapter describes the operations that can be performed in Nikon
View’s main window once you have acquired documents from the camera.

Acquiring Documents from the Camera

To acquire documents from the camera, select the desired documents in the
browser’s preview window. Once you have selected the documents you
wish to play back or edit, click the Acquire button in the browser tool
palette.

While the selected documents are being read from the camera’s memory,
the following progress indicator will be displayed.

Acquire
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Once the documents have been read from the camera, they will be opened
in document windows within the main window.

Zoom

If the acquired document contains a photograph or memo, you can zoom in
on the image by placing the mouse pointer anywhere within the document
window and clicking. The cursor will take the shape of a magnifying glass
( ) while in the document window. To zoom out, hold down the Ctrl
key on the keyboard and click anywhere in the document window.  While
the Ctrl  key is held down the zoom cursor will contain a minus sign ().
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Scrolling and Resizing the Document Window

When the entire image does not fit in the document window, you can view
hidden portions by dragging the scroll sliders at the right and bottom of the
window, or by clicking the scroll bars or arrow buttons. Alternatively, you
can enlarge the window itself dragging the window’s borders.

If the main window is large enough, you can also view the entire document
at its current zoom ratio by clicking the Fit Window to Image button in the
main window tool bar or by selecting Fit Window to Image  from the
View  menu.

Scroll slider

Scroll bar

Arrow button

Fit Window to
Image
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The document window will be either enlarged to show the entire image or,
if the image is too large to fit in the main window, enlarged to fill the main
window.

If the document is too large to fit in the main window, you can view the
entire image by selecting View Entire Image  from the View  menu.

The image will be adjusted to a zoom ratio at which it will fit in the main
window, and the document window will be adjusted to show the entire
image.
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Rotating Images

Images in a document window can be rotated ninety degrees to the left by
clicking the Rotate 90˚ Counterclockwise button in the document window
tool bar. The image will be rotated ninety degrees left each time the button
is clicked.

Rotate 90˚
Counterclockwise

This operation can also be performed on the currently active document by
clicking the Rotate 90˚ Counterclockwise button in the main window tool
palette or by selecting 90˚ CCW from the Rotate  submenu in the Tools
menu.

Rotate 90˚
Counterclockwise
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Rotate 90˚
Clockwise

To rotate the image ninety degrees to the right, click the Rotate 90˚
Clockwise button in the document window tool bar. The image will be
rotated ninety degrees clockwise each time the button is pressed.

Rotate 90˚
Clockwise

You can also perform this operation on the active document by clicking the
Rotate 90˚ Clockwise button in the main window tool palette of by
selecting 90˚ CW from the Rotate  submenu in the Tools  menu.

The active document can also be rotated 180 degrees at a time by selecting
180˚ from the Rotate  submenu.
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This operation can also be performed on the active document by clicking
the Flip Horizontal button in the main window tool palette or by pulling
down the Tools  menu and selecting Horizontal  from the Flip  submenu.

Flipping Images

Clicking the Flip Horizontal button in the tool bar of a document window
flips any image it may contain horizontally.

Flip Horizontal

Flip Horizontal
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You can also perform a vertical flip on the active document by clicking the
Flip Vertical button in the main window tool palette or by pulling down the
Tools  menu and selecting Vertical  from the Flip  submenu.

The active document can be flipped both vertically and horizontally by
choosing Both Axes  from the Flip  submenu.

An image in a document window can be flipped vertically by clicking the
Flip Vertical button in the tool bar of the document window.

Flip Vertical

Flip
Vertical
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Printing Images

Images in the active document window can be printed using the commands
available in the File  menu. To choose a printer and set the page size and
printing options, choose Print Setup…  from the File  menu.

The Print Setup window will appear.
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The options in the Print Setup window are described below.

Name
Lists the name of the currently selected printer. Clicking the arrow key
to the right of the listed printer will bring up a list of the printer drivers
currently installed on your system, allowing you to select a different
printer. The type, location, and current status of the selected printer are
listed beneath this item.

Properties
Clicking this button brings up the Properties dialog for the selected
printer, where you can change paper size and graphics settings. The
actual contents of the Properties dialog depend on the printer selected.

Size
This item provides a list of the paper sizes supported by the selected
printer. The currently selected size is displayed in the list box.

Source
This item allows you to select a paper tray (source) from among those
supported by the printer. The currently selected source is displayed in
the list box.

Orientation
These radio buttons allow you to choose from Portrait  (tall) or
Landscape  (wide) settings, determining how the document will
oriented when it is printed.

OK
Accepts the listed printer settings and returns you to the main window.

Cancel
Discards any changes to printer settings and returns you to the main
window.
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Once you have selected a printer, paper size, and orientation, you can see
how the active document will print under these settings by choosing Print
Preview…  from the File  menu.
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A preview image showing how the active document will print will appear
in the main window.
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Using the buttons at the top of the preview window, you can view all pages
of the document and zoom in or out on the preview. The functions of these
buttons are detailed below.

Print…
Brings up the Print dialog box (see below), allowing you to print the
previewed document.

Next Page
Previews the next page of a multi-page document. If the page currently
displayed is the last page in the document, this button will be dimmed
and inactive.

Prev Page
Previews the page immediately preceding that currently displayed. If
the current page is the first page in the document, this button will be
dimmed and inactive.

Two Page
Causes pages to be displayed two at a time in the preview window. If
the active document fits on a single page, this button will be dimmed
and inactive.

Zoom In
Zooms in on the preview image. This operation can also be performed
by clicking the preview image. While the mouse pointer is over the
preview, the cursor will take the shape of a magnifying glass ().

Zoom Out
Zooms the preview image out.

Close
Closes the preview window and returns you to the document window.
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If, after viewing the print preview, you are satisfied with how the
document will print, you can print the document by choosing Print…  from
either the File  menu or the print preview window.

The Print dialog will appear.



89Working with Documents : Printing Images

The options available in the Print dialog are explained below.

Name
Lists the name of the currently selected printer. Clicking the arrow key
to the right of the listed printer will bring up a list of the printer drivers
currently installed on your system, allowing you to select a different
printer. The type, location, and current status of the selected printer are
listed beneath this item.

Properties
Clicking this button brings up the Properties dialog for the selected
printer, where you can change paper size and graphics settings. The
actual contents of the Properties dialog depend on the printer selected.

Print to fi le
If you click OK in the Print dialog when this box is checked, the
document will not be printed to the specified printer but will instead be
printed to a file using the current printer settings.

Fit to page
When this radio button is selected, the document will be scaled to the
largest size that will fit on the page.

Resolution
When this radio button is selected, you will be able to specify the
resolution at which the document will be printed. The desired
resolution can be entered directly in the text box to the right of the radio
button. The lower the resolution, the larger the size of the document
when printed; if the document is too large to fit on the page at the
current resolution, a warning will appear informing you of this fact.

OK
Prints the document at the specified settings and returns you to the main
window.

Cancel
Returns you to the main window without printing the document.

Help
Brings up the Print help topic.
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If the active document contains a recording, this function can also be
accessed by selecting Play Sound  from the View  menu.

Playing Back Sound Recordings

If a document contains an audio recording, you can play it back by clicking
the Play Sound button on the document window tool bar.

Play Sound
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The Play Sound dialog will appear.

You can move to any point in the audio clip by moving the slider bar. The
number underneath the slider bar gives your current position in the clip; the
number at right end of the slider shows the total length of the recording.
To play the recording back, click the Play button (). Playback can be
ended by clicking the Stop button ().  Clicking the Rewind button ( )
returns you to the beginning of the recording, while clicking Fast Forward
( ) takes you to its end.

While the Play Sound dialog is open, you can save the current recording by
clicking the Save button. This will bring up the Save As dialog (see
“Saving Documents,” below), allowing you to save the recording to disk as
a “.WAV” file.

When you have finished playing the recording back or saving it to disk,
click the Close  button to close the Play Sound dialog and return to the
main window.



92 Working with Documents : Getting Information about a Document

You can also get information about the active document by selecting
Show Information  from the View  menu.

Getting Information about a Document

Clicking the Show Information button in the document window tool bar
will bring up the Information window, which provides details of the
document’s title, size, location, and date and time of recording.

Show Information
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The Information window is shown below.

In addition to the document’s title, date of recording, and the amount of
space it occupies on disk or in the camera’s memory, the Information
window also gives the document’s dimensions in pixels and the total
amount of RAM or virtual memory used when the document is open.
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Saving Documents

The image in the active document can be saved to disk under a specified
name and file format by selecting Save As…  from the File  menu.

The Save As dialog will be displayed.
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The options available in the Save As dialog are explained below.

Save in
Allows you to specify a destination drive and directory for the
document.

Up One Level
Moves you up one level in the directory structure.

Create New Folder
Creates a new directory under the current directory and allows you to
specify a name for it.

List/Details
Toggles the display to show either a simple list of icons and file names,
or a detailed list giving file name, size, type, and date saved.

File name
A name of your choice can be entered in this text box.
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Save as type
If the document is an image, the
file type can be selected from the
pop-up menu shown at right.
Images can be saved in bitmap (BMP) JPEG, or TIFF formats. Audio
data will be saved as sound files in “.WAV” format.

If the selected file type is JPEG, a pop-up menu will appear at the
bottom of the Save As dialog, offering a choice of image quality
settings for the new file.  This JPEG Compression  menu is shown
below.  The choices offered range from Excellent quality , which
produces the highest quality images
but also makes the greatest demands
on disk space, to Highest
compression ratio , which produces
lower-quality images requiring less
disk space to store.

Save (Open )
Saves the document in the current directory and returns you to the main
window. If a directory is selected in the file list, this button will change
to read Open . Clicking this button will then open the selected
directory.

Cancel
Returns you to the main window without saving the document.
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Once a document has been saved to disk, any further changes can be saved
to the same file by clicking the Save button in the main window tool bar or
by selecting Save from the File  menu.

 

Save
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Reading Documents from Disk

Documents previously saved to disk can be opened in the main window
simply by dragging the file’s icon into the main window. The document
will then be opened in a new document window. You can also open
documents by clicking the Open button in the main window tool bar or by
selecting Open…  from the File  menu.

 

The Open dialog will appear.

Open
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The items in the Open dialog are explained below.

Look in
Allows you to navigate the directory structure to locate the desired
drive and directory.

Up One Level
Moves you up one level in the directory structure.

Create New Folder
Creates a new directory under the current directory and allows you to
specify a name for it.

List/Details
Toggles the display to show either a simple list of icons and file names,
or a detailed list giving file name, size, type, and date saved.

File name
Lists the file that will be opened when you click Open .

Files of type
Specifies the file types that will appear in the file list.

Open
Opens the selected file and returns you to the main window. If a
directory is selected in the file list, clicking this button will open the
selected directory.

Cancel
Returns you to the main window without opening any documents.
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The About Window

To view the About window, which gives copyright and version information
for Nikon View, choose About NikonView…  from the File  menu (if the
browser is being used from another application, the About…  command
may be found at the bottom of the browser window control menu).

The About window will appear.

Click anywhere in the window to clear it from the screen.
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Appendix A: Nikon View for Windows 3.1

This appendix lists differences between the Windows 95 and Windows 3.1
versions of Nikon View. But for small differences in the design of the
desktop and of such standard Windows dialogs as Open, Print, and Save,
the operating procedures for the Windows 95 and Windows 3.1 versions
are identical. The steps involved in installing the software however differ
slightly, and these differences are noted in the following section.

Installation

Before installing the software, check that your system meets the
requirements listed in “Before You Begin” and that there is sufficient free
disk space to complete the installation and run Nikon View.  A minimum of
22 MBs of free disk space is required, of which 1 MB must be available on
the drive to which Windows has been installed.  If it has not already been
installed, more disk space will be needed to install Win32s  (required for
running Nikon View under Windows 3.1). Additional space will also be
required should you wish to install the software bundled with Nikon View
on the installation CD.  After starting Windows and making sure that no
other applications are running, you can begin the installation procedure.

Step 1 — Ready the installation disk

Insert the installation CD into the CD-ROM drive.
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Step 2 — Launch the setup program

To start the setup procedure, choose Run…  from the File  menu in the
Program Manager.

The Run dialog box will be displayed.

In the Command Line  text box, type the drive letter of your CD-ROM
drive followed by \WELCOME.EXE (if your CD-ROM drive were drive
D:, for example, you would type D:\WELCOME.EXE ) and click OK.
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Step 3 — Install Nikon View

Launching the welcome program will cause the Nikon View Setup dialog
to be displayed.

Note the addition of Video for Windows to the list of bundled software.  If
your sound card does not support the 8KHz format native to the COOLPIX
300, you can install this program to enable your computer to play back the
camera’s audio data.

Once the Nikon View Setup dialog has been displayed, you can continue
with installation of Nikon View as described in “Before You Begin,”
starting from Step 2 and continuing through Step 5.
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Step 4 — Install additional software

Nikon View is a 32-bit application which requires Win32s to run under
Windows 3.1.  If Win32s has not already been installed on your system,
the Nikon View installer will install it automatically, but before you will be
able to use the 32-bit drivers you will need to restart Windows.  If Win32s
has been installed by the Nikon View setup program, the following message
will be displayed when installation is complete.

If you wish to install additional programs from the installer CD, select No,
I will restart my computer later  and click OK to return to the Nikon
View Setup dialog.  After making any additional installations, restart
Windows by selecting Exit Windows…  from the File  menu in the
Program Manager and then typing “win” at the system prompt.

If you do not want to install any additional software at the present time,
select Yes, I want to restart Windows now  and click OK.  You can
install additional software at a later date by repeating the installation
process from Step 1.
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After Nikon View has been installed, the Nikon View program group will be
open in the Program Manager.

Note the addition of unInstallShield to the program group. If you should
decide that you no longer need Nikon View, you can run this program to
remove it from your hard disk. To use Nikon View again after running the
uninstaller program, you will have to repeat the installation procedure.

Step 5 — View the README file

It is recommended that you take a few moments to view the README file,
which may contain important information that could not be included in this
manual. To view the README file, double-click the README icon in
the Nikon View program group. When you have finished reading the
README file, choose Exit  from the File  menu to close the file and return
to Windows.
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Index
“Compression Mode” pop-up menu  52
Control menu

in browser window  43
in document window  39
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COOLPIX 300
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computer  52–54, 66–68
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58–60
Copy button  36
“Copy” command  28
Cut button  36
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Delete button  44, 73
“Delete” command  28
“Delete images after acquisition” check

box  51, 69
Descending button  45, 65
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in browser preview window  61–62
in Window menu  33
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38–41,  75–82,  90–93

resizing  77
scrolling  77–78

Documents  19
acquiring from camera  19, 69,

75–76
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deleting  73–74
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reading from disk  98–99
saving  20, 70–72, 94–97

Symbols
“180˚” command  32, 80
“90˚ CCW” command  32, 79
“90˚ CW” command  32, 80
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About window  100
Acquire button  19, 44, 69, 75
“Arrange Icons” command  33
Ascending button  45, 65
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playing back  90–91
recording  68
saving to disk  91, 96

“Auto Fit Window to Image” command
30

B
Battery level indicator  45
“Both Axes” command  31, 82
Browser  1, 22–23, 47–74

opening  57–60
Browser window  19, 22–23, 42–46
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sorting documents in  65

C
CAPS  37
“Cascade” command  33
“Close All” command  33
“Close browser after acquisition” check

box  69, 51
“Close” command

in browser window control menu  43
in document window control menu

39
in File menu  26
in main window control menu  25
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E
Edit menu  28
Exit button  21, 35
“Exit” command  21, 27

F
File formats

BMP  1
JPEG  1, 72,  96
TIFF  1
WAV  1, 72

File menu  26–27
Fit Window to Image button  37, 77
“Fit Window to Image” command

29, 77
“Flash Mode” pop-up menu  53,  67
Flip Horizontal button

in document window tool bar  40, 81
in main window tool palette  34, 81

Flip submenu  31
Flip Vertical button

in document window tool bar  40, 82
in main window tool palette  35, 82

G
“Generate Unique Names” check box

71

H
Hide Thumbnails button  45, 62
“Horizontal” command  31, 81

I
Images

flipping  65,  81–82
rotating  65,  79–80

Information window  64, 92–93
Installation  4–14

Windows 3.1  101–105
Interactive help  37

M
Main window  17, 22–23, 24–37
“Maximize” command

in browser window control menu  43
in document window control menu

39
in main window control menu  25

Memo mixer  51, 61
“Minimize” command

in browser window control menu  43
in document window control menu

39
in main window control menu  25

“Move” command
in browser window control menu  43
in document window command

menu  39
in main window command menu  25

N
“Next” command

in browser window control menu  43
in document window control menu

39
NUM  37

O
Open button  36, 98
“Open…” command  26, 98
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P
Paste button  37
“Paste” command  28
Photographs, taking  66–68
Play Sound button

in browser preview window  46, 63
in document window tool bar  40, 90

“Play Sound” command  30, 90
“Play sound through…” radio button

51
Play Sound window  91
Preferences  48–56, 61, 63, 66

browser tab  50–51
camera tab  52–54
scratch disk tab  55–56

Preferences button  35
“Preferences…” command  27, 48
Print button  37
“Print Preview…” command  27,

85–87
“Print Setup…” command  27, 83–84
“Print…” command  27, 88–89
Program icon  16

Q
Quitting Nikon View  21

R
README file  5, 11, 105
Recent files list  27
“Record Sound When Taking a Picture”

check box  53, 68
“Restore” command

in browser window control menu  43
in document window control menu

39
in main window control menu  25

Rotate 90˚ Clockwise button
in document window tool bar  41, 80
in main window tool palette  35, 80

Rotate 90˚ Counterclockwise button
in document window tool bar  41, 39
in main window tool palette  35, 80

Rotate submenu  32
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S
“Save As…” command  26, 94
Save button

in browser window tool palette
44, 70

in main window tool bar  20, 36, 97
“Save” command  20, 26, 97
“Save Sound” check box  71
SCROLL  37
SCSI  3, 13–14, 18, 59
SCSI cable  66
Serial connection  3, 18, 59
Show Browser button  34, 57
“Show Browser” command  30, 57
Show Information button

in browser preview window  46, 64
in document window tool bar  42, 92

“Show Information” command  30, 92
Show Thumbnails button  45, 62
Shutter button  44, 66
“Size” command

in browser window control menu  43
in document window control menu

39
in main window control menu  25

Sort by Name button  45, 65
Sort by Time button  45, 65
Starting Nikon View  16–18
Status bar  37
“Status Bar” command  30, 37
System requirements  3

T
“Tile” command  33
Toggle Memo button  46, 63, 69
“Toggle Memo” command 30
Tool bar

in document window  38, 40–41
in main window  36–37

Tool palette
in browser window  42, 44–45
in main window  17, 23, 34–35

"Toolbar" command  30, 38
Tools menu  31–32

V
“Vertical” command  31, 82
“View Entire Image” command  29, 78
View menu  29–30

W
Window menu  33
Windows 3.1  2, 4, 101-105

Z
Zoom  19, 76


	Contents
	Overview
	Before You Begin
	System Requirements
	Installation

	Getting Started
	First Steps
	A Closer Look at Nikon View
	The Main Window
	Document Windows
	The Browser Window


	Using the Browser
	Preferences
	Opening the Browser Window
	Previewing Documents
	Taking Photographs
	Transferring Documents to Another Application
	Saving Documents to Disk
	Deleting Documents

	Working with Documents
	Acquiring Documents from the Camera
	Zoom
	Scrolling and Resizing the Document Window
	Rotating Images
	Flipping Images
	Printing Images
	Playing Back Sound Recordings
	Getting Information about a Document
	Saving Documents
	Reading Documents from Disk

	The About Window
	Appendix A: Nikon View for Windows 3.1
	Installation

	Index


